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Introduction

How to use this manual Symbols used in the sequence of operation

This manual describes the basic
operation of the TPS400 Mining [MENU]  Press the [MENU] button

field programs. It shall be used
together with a TPS400

instrument. @D - @ Press the function button [F1-F4]
For detailed description about A

the whole functionality of the <« > Navigation keys

TPS400 instrument please refer v

to the TPS400 User Manual.

@ Repeat operation

@A User input is necessary

Ig: Important paragraphs which must be adhered to in
practice as they enable the product to be used in a
technically correct and efficient manner.

TPS400 Mining Ma%‘%’rﬁga@?ﬂom Www.SomarMuals Search And Download. Introduction



Peg Survey

Introduction

The application "Peg Survey" is
used to establish a forward peg
(point). It is used to control the
intermediate horizontal angle
between backsight and foresight
points. It also checks the
horizontal distances and heights
of the backsight and foresight
points. It computes the
coordinates of the foresight
point. "Peg Survey" allows users
to measure several sets in
different sequences. (The
quality of measurement is
controlled by the tolerances
which are set before starting
"Peg Survey").

Backsight Point

Station

Foresight Point

Mining_z01

Known:

» Coordinates of station
+ Coordinates of backsight

point

Unknown:
» Coordinates of foresight point

TPS400 Mining Manual-1.0.0en
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Before starting Peg Survey

Data uploading using "Mining |g’ Uploading of fixpoint

Editor" coordinates, tolerances,
« Station coordinates sequence and number
(East, North, Height of sets is mandatory to
Grade elevation) enable the operation of
"Peg Survey".

» Backsight point coordinates
(East, North, Height,
Grade elevation)

» Tolerances, sequence,
number of sets

» Job definition

<=n

To create new jobs on
board the instrument, a
set of tolerance must be
available.
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Start and execution Peg Survey
* Press [MENU] and [F1] for RS CTeY  Choose "Start" by > Step 4 @EI=0|

programs. pressing [F4], then Set Point number
« Press [F1] for Peg Survey. enter point number .(PtID) and .
) (PtID) and instrument height
Select a job. instrument height (hi).
Confirm the set of (hi) for the station.
tolerances. The sign for the [EXIT] Leaves "Input
Ig instrument height Station" and returns
(hi) is normally to the start-up menu.
negative.
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Error messages

Station or BS point has no
valid coords !

* The point number entered is
not available in the internal
memory or it has invalid
coordinates.

7,

Re-enter point number

i>sten 3 |}

Sample dialog:

Number of sets:

One set means to measure two
times the backsight point and
two times the foresight point in
both faces.

The meaning of set is

Survey will be
executed according to
the following settings:

BFFB

described:
One Set
| Set
BS FS
Two Sets

A

Mining_z02

FS
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The user must complete
the number of sets as
preset in the tolerance
setting.

Peg Survey



Proceeding Peg Survey

Sequence: Sample dialog: Measure Backsight Point
Information about which
It defines the measuring backsight point the user has to
sequence. measure.
. Set 1
Options: of total 3 [OK] Leaves this dialog
- BFFB and proceed to the
Backsight-Foresight- measure dialog.
Foresight-Backsight
- BFBF
Backsight-Foresight- Set 1 of total 3
Backsight-Foresight Start with measurement first set
- BBFF of three.
Backsight-Backsight-
Foresight-Foresight [OK] Leaves this dialog
and proceed to the
[OK] Leaves this dialog next dialog.
and proceed to the
next dialog.

TPS400 Mining Manual-1.0.0en | 10 | Peg Survey
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Proceeding Peg Survey, continued

Sample dialog:

1/3

PtID 150
Hz 5 98°12'45"
v 5 99°45'23"
hr B -1.263 m
HD : @ ee------ m

SEARCH |MEASURE

Enter the reflector
height (hr) for the
backsight point, if
required.

ERSIGTNE] Aim at backsight

point and measure.

[MEASURE] or [DIST]/[REC]
Angle and distance
measurements are
triggered and stored
in the internal
memory.

[SEARCH] Allows users to
search and choose a
different backsight
point.

[EXIT] Terminates the
program and returns

to the start-up menu.

TPS400 Mining Ma%‘%’rﬁ&a@?ﬂom Www.SomaMuals Search And Download.

[OK]

Enter a desired
foresight point
number (PtID).

Saves the foresight
point number and
proceed to the
measure dialog.

Peg Survey



Proceeding Peg Survey, continued

Sample dialog: [MEASURE] or [DIST)/[REC] [REJECT] Reject the

Angle and distance measurement and
Foresight Point 1/3 measurements are measure the set
PtID : 151 triggered and stored again.
Hz 198°12'45" in the internal [ACCEPT] Accept the result
v s Breas 2 memory. and continue with
oo OB [EXIT] Terminates the the next set.

program and returns
to the start-up menu.

LR Gl Enter the reflector Repeat ERIE K3
height (hr) for the @ and BRG] until

foresight point, if all sets are
required. measured.
IZ;—" If the tolerances
RG] Aim at foresight after a set are not
point and measure. met, the user has

the option to
continue with the
measuring or
rejecting the data.

TPS400 Mining Manual-1.0.0en I Peg Survey
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Results

Sample dialog:

TOLERANCES MET ! (PAGE1)
dHz 5 00°00'25"
TolHz 00°00'50"
dHD BS 0.001 m
dHD FS 0.003 m
TolHD 0.006 m

[PAGE]

Sample dialog:

TOLERANCES MET ! (PAGE2)
dHD BS 0.003 m
dHD FS 0.001 m
TolH : 0.004 m
Set No <ALL SETS>

Tolerances dialog:

* dHz: Residual on the
horizontal angle

» dHD: Residual on the
horizontal distance

« dH: Height residual

* TolHz, TolHD, TolH:
Tolerances horizon-
tal angle, horizontal
distance and height

* Set No: Set number

TPS400 Mining Ma%‘%’rﬁé’a@?ﬂom Www.SomarMuals Search And Download.

[OK]

[EXIT]

Leaves this dialog
and proceed to the
result dialog.

Terminates the
measurement and
returns to the start-
up menu.

Peg Survey



Results, continued

Sample dialog:

TRAVERSE RESULT (PAGET1)
mHz 56°36'25"
mHDBS 56.465 m
mHBS 0.786 m
mHDFS 46.632 m
mHFS 1.236 m

[PAGE]

Sample dialog:

TRAVERSE RESULT (PAGE2)

Pt BS: 101
Pt FS: 102
mHz  : 56°36'25"
Seq BFFB
Num 2

Result dialog:

* mHz: Average
intermediate horizontal angle
between backsight point and
foresight point

* mHDBS/FS: Average
horizontal distance
(Backsight and Foresight)

« mHBS/FS: Average height
(Backsight and Foresight)

« Pt BS/FS: Point number
(Backsight and Foresight)

* Seq: Sequence

¢ Num: Number of sets

Backsight Point Station

Foresight Point

Mining_z03
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Results, continued

Saving data

[OK]
[EXIT]

Quits the program.

Terminates the
measurement and
returns to the start-
up menu.

The following result data are
stored in the internal memory:

Result:
mHz:

mHD:

mH:

TPS400 Mining Ma%‘%’rﬁé’a@?ﬂom Www.SomarMuals Search And Download.

Average
intermediate
horizontal angle
between backsight
point and foresight
point

Average horizontal
distance (backsight
and foresight)

Average height
(backsight and
foresight)

Residual:

dHz: Residual on the
horizontal angle

dHD: Residual on the
horizontal distance

dH: Height residual

Coordinates foresight point:

E: Easting

N: Northing

H: Height point
GrEl: Grade Elevation

Peg Survey



Front Line Peg

Introduction

The application "FLP" is used to
mark a new line peg (Front line
peg). This application is similar
to "Peg Survey" and there is
only one set of measurement
required.

For a more detail explanation of
"FLP", please refer to chapter
"Peg Survey".

TPS400 Mining Manual-1.0.0en | 16 | Front Line Peg
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Introduction

"Grades" application is used to
mark gradelines along the side
walls of the mines (tunnels). It
allows users to input the slope
gradient and an offset
concerning the grade point. It
computes the stake out height
difference. The program allows
also to map the positions of the
grades points along the
gradelines.

Known:

» Coordinates and grade
elevation of station

» Coordinates and grade
elevation of backsight point

Backsight Point Station

Mining_z04

Foresight Point

H = Current height of
gradeline above mine floor

dH = New height difference
input for new gradeline

+ Slope gradient (station until
foresight point)

» Height difference (dH)
between current gradeline
and new gradeline

TPS400 Mining Ma%‘%’rﬁ&a@?ﬂom Www.SomarMuals Search And Download.

Unknown:

» Stake out height difference
(dHgt) between measure
point and gradeline point

* Horizontal distance (dHD)
along the foresight line

Grades



Start and execution Grades

You can start Grades either by

selecting it in the program or
after measuring in the
application "Front Line Pag".

Ig When you start it from
programs you have to
enter station data and
measure to back- and
foresight point first.

Menu dialog of "FLP":

Sample dialog:

CONTINUE WITH ...

GRADES | OFFSET

GRADES

Grade (1:x): 4.123
Grade (%) : 24.25 %
Grade (Ang):

13°38'00"
Direction Down (-) 4»
Height 3 0.500 m

I? If the slope gradient
(station until foresight

point) is the same like
the slope gradient
(backsight point until
station) then continue

direct with ERSICToRY.

TPS400 Mining Manual-1.0.0en
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Start and execution Peg Survey, continued

ERSICT B Enter the slope

gradient

(proportion e.g.

1:150).

Slope gradient explained:

1WA Enter the height
difference.

Height difference explained:

'L\\.f’f’adeﬁne
1 O

150

Mining_z05

Station Foresight Point

Mining_z06

dH:

H: Current height of

gradeline above
mine floor

Height difference

TPS400 Mining Ma%‘%’rﬁga@?ﬂom Www.SomaMuals Search And Download.

[EXIT]

[SET] Set the
entered values and
proceeds to the
gradeline marking
dialog.

Leaves the
application "Grades"
and return to the
menu dialog of
"FLP".

Grades



Gradeline Marking

Sample dialog:

GRADELINE MARKING
PtID: 100
dHgt: 0.552 m
dHD : 3.123 m
Hz 126°56'23"
HD 10.365 m

ERSICT WY Enter a desired point
number (PtID).

ERSICTRY  Aim at target point
and measure.

[MEASURE] or
[DIST)/[REC]
Measurement is
triggered and stored
in the internal
memory.

[PREV]

TPS400 Mining Manual-1.0.0en

Returns to the start
of "Grades"
application.

For a new definition
of slope gradient
and height
difference repeat

> Step 1 Wil
> Step 3§

[EXIT]

Leaves the
application "Grades"
and return to the
menu dialog of
"FLP".

Grades
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Results

Grades computes the height difference (dHgt) between measure point and stake out point and the
horizontal distance (dHD) along the foresight line.

Height difference (dHgt) and horizontal distance (dHD) explained:

Station

Foresight Point

Mining_z07

Foresight

Point New

Gradeline
point

dHD

Station

Mining_z08

TPS400 Mining Ma%‘%’rﬁ&a@?ﬂom Www.SomaMuals Search And Download.
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Results, continued

Saving data

If the sign is
negative the grade
point are above the
measure point.

=N

If the sign is positive
the grade point are
below the measure
point.
Turn the telescope
until the height
difference (dHgt) is
zero, then repeat the
measurement

{ > Step 5}

The following result data are
stored in the internal memory:

Measurement data:

PtID: Point number

Hz: Horizontal angle
Vertical angle

HD: Horizontal distance

SD: Slope distance

dH: Height difference

Coordinates of new gradeline
point:

E: Easting
N: Northing
H: Height

Grades Result:

daH: Stake out height
difference

daHD: Horizontal distance
along the foresight
line

Grd: Slope gradient

GE: Grade elevation

TPS400 Mining Manual-1.0.0en
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Introduction

"Offset" application is generally
used to obtain sections of the
tunnels for volume computation
as well as mapping of the
tunnels. It allows users to input
offset value (left, right, up and
down) and computes after
measurement the actual
coordinates of the tunnel walls.

Backsight Point

Station

Foresight Point

£
Known: Unknown:
» Coordinates of station * Point coordinates of the
+ Coordinates of backsight tunnel walls
point
+ Offset value
Offset

TPS400 Mining Ma%‘%’rﬁ&a@?ﬂom Www.SomaMuals Search And Download.



Start and execution Offset

You can start Offset either by Menu dialog of "FLP": Sample dialog:

selecting it in the program or

after measuring in the OFFSET

application "Front Line Pag". PtID : 100
Offset: 1.500 m

Ig, When you start it from CONTINUE WITH ... LEFT 4)

programs you have to
enter station data and
measure to back- and GRADES | OFFSET
foresight point first.

Hz B 123°12'36"

ERSICT B Enter a desired point
number (PtID) and

the offset value.

> Step 2 VSIS
for the offset
definition.

O (Left, Up, Right, Down)
<« (Left, Down, Right, Up)

TPS400 Mining Manual-1.0.0en | 24 | Offset
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Start and execution Offset, continued

Definition of offset explained:

Mining_z10

Mining_z11

G ]  Aim at target point

and measure.

[MEASURE] or [DISTJ/[REC]

[EXIT]

TPS400 Mining Ma%‘%’rﬁ&a@?ﬂom Www.SomaMuals Search And Download.

Measurement is
triggered and stored
in the internal
memory.

Leaves the

application Offset
and return to the

menu dialog of "FLP".

After storing, the
program returns to
the measuring
dialog.

If you want to
measure a new point

repeat BRI ol
until EESICT Y .

Offset



Results

Saving data

The following result data are
stored in the internal memory:

Measurement data: Offset information:
PtID: Point number Offset: Offset value
Hz: Horizontal Angle OffsetDir: Offset direction
V: Vertical Angle (left, up, right, down)
HD: Horizontal distance
SD: Slope distance
Ig The measurement
data are already
corrected.

Coordinates of new offset
point:

E: Easting
N: Northing
H: Height

TPS400 Mining Manual-1.0.0en
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Polar setout

This program calculates the
required elements to stakeout
points from coordinates or
manualy entered angles,
horizontal distances and
heights. Setting out differences
can be displayed continuously.

Setting out coordinates from

memory

Procedure:

4 Select the point.

[DIST] Starts measurement
and calculation of
the stake-out
elements.

[REC] Saves the displayed
values.

[B&D] Input direction and
Hz-distance of stake
out point.

[MANUAL] Enables simplified

input of a point
without ptID and
without the
possibility of storing

the data of the point.

Normal indication of polar setout
offsets dHz, dHD, ddH.

Point to
be setout

dHz: Angle offset: positive
if point to be set-out
is to the right of the

actual direction.

dHD: Longitudinal offset:
positive if point to be
setout is further

away.
Height offset:
positive if point to be
setout is higher than
measured point.

ddH:

TPS400 Mining Ma%‘%’rﬁ&a@?ﬂom Www.SomaMuals Search And Download.
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Orthogonal setout

Cartesian setout

The position offset between
measured point and setout point
is indicated in a longitudinal and
transversal element.

Actual

Point to

dLength: Longitudinal offset:
positive if nominal
point further away.
dTrav.: Transversal offset,

perpendicular to
line-of-sight: positive
if nominal point is to
the right of
measured point.

dHeight:

Height offset:
positive if point to be
setout is higher than
measured point.

Setting out is based on a
coordinate system and the
offset is divided into a north and
east element.

Point to
be setout
Actual 1

N
/ +dEast = +dNorth
@%
T

dEast

Easting offset
between setout and
actual point.

Northing offset
between setout and
actual point.

Height offset:
positive if point to be
setout is higher than
measured point.

dNorth

dHeight:

TPS400 Mining Manual-1.0.0en
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The application Tie Distance
computes slope distance,
horizontal distance, height
difference and azimuth of two
target points measured online,
selected from the Memory or
entered using the Keypad.
The user can choose between
two different methods:

@D Polygonal (A-B, B-C)
@D Radial (A-B, A-C)

Polygonal Method:

1.

SD 2-3

T303

Radial Met

hod:

N
$
S
S
7
£ 1
ﬁfentre poil

/AZY-4—

i Slope distance 1-3
/ Az 1-
/Az 1-3: 2
3

Slope distance 1-2

nt

Slope distance 1-4

In principal
the same.

both methods are

Any differences will be

described.
Procedure:

1. Determine first target

point.
[ALL]

[FIND]

TPS400 Mining Ma%‘%’rﬁ&a@?ﬂom Www.SomaMuals Search And Download.

Starts measurement
to the target point.
Searches internal

memory for point
entered.

2. Determine second target
point.
Proceed as with first target
point.

3. Result is displayed.

Brg Azimuth between

point1 and point2.

Slope distance
between point1 and
point2.

Horizontal distance

between point1 and
point2.

dsSD

dHD

ddH Height difference
between point1 and

point2.

Tie Distance



Softkeys - polygonal method:  Softkeys - radial method:

[NewPt 1] An additional [NewPt 1]
missing line is
computed. Program  [NewPt 2]
starts again (at
point 1). [POLY]
[NewPt 2] Point 2 is set as
starting point of a
new missing line.
New point (Pt 2)
must be measured.
[RADIAL] Switches to radial
method.

TPS400 Mining Manual-1.0.0en
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Determine new
central point.
Determine new
radial point.
Switch to poly-
gonal method.

Tie Distance



Mining Editor

Introduction Installation on the PC Program content

"Mining Editor" (PC Program The installation program for the = The "Mining Editor" can be used
Package) is a Windows-based "Mining Editor" can be found on  for the following purposes:
program used for the data the CD-ROM supplied. Please

exchange between the TPS400  Note that the "Mining Editor” » Data Import & Export

Series and the PC. program can only be installed Import and export fixpoint

under the operating systems MS files (ASCII format).

Wind 95, 98, ME, NT4.0,
Wllrrlu:?g\jvszooo, XP. « Data Transfer between PC

and TPS400 instrument

For the installation call program
prog Upload and download of

"setup.exe" in the directory fixpoint fil load of
"MiningEditor\Disk1" on the CD- oo 'esa SN d° ;
ROM and follow the onscreen tolerances, download o

instructions to complete the measurgmenft data and t
installation. conversion of measuremen

data to various formats for
peg calculation and archiving.
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Program content, continued

Practical Examples

» Define and upload
Tolerances
Defining tolerances, editing
tolerances (password
protected), uploading
tolerances

» Creating fixpoint files
Creating and editing of
fixpoint files (Coordinates)

The following pages of the
manual describe the
functionality of "Mining Editor'
with two practical examples.

* Example1:

Creating fixpoint files, Define
tolerances, Uploading them
to the instrument

* Example2:

Importing of fixpoints in ASCII

format

TPS400 Mining Manual-1.0.0en
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First Example (Creating fixpoint files, define tolerances, uploading)

Creating fixpoint files Define tolerances

ERSCTOME  Open a new file: File > New LR E  Open tolerances:

BT WA Enter point number, coordinates, Options > Tolerances - Edit
backsight reference point, grade ERSICTWd  Enter a password.
elevation.

Create a new password:
Options - Password

77.765 55987 90.265 P100

883656  6£0.325 91.354 P101

Select a measuring sequence
(BFFB, BFBF or BBFF).

ERSICT ] Save the created coordinate list:

B = Backsight point and F= Foresight
File > Save As Ig’ ( i ome 9
point).
Ig’ In the fixpoint entry module, the iG] Enter number of sets.

"Mining Editor" allows users to create,
view, modify and save coordinate lists.
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First Example (Creating fixpoint files, define tolerances, uploading), continued

Upload Fixpoints and LRSI Enter jobname,
Tolerances to the instrument operator and
comments.

Ig’ Ensure that the unit |§ Operator and

setting on the comments are

instrument (Menu / optional.
All Settings / Unit
Settings) is identical TR Select a tolerance
to the units set in type.
the "Mining Editor"
(Options 2>
Settings).
> Step 5
a) Select a folerance type STl Oven a fixpoint file:
(Primary, Secondary, Firl)e > OpZn
Tertiary).
- S1EW4  Choose Upload:
b) Enter the values for: i Data > Uzload

* Horizontal Angle Limit .
RS CTok]  Select a job.
» Horizontal Distance Limit !

* Height Limit

TPS400 Mining Manual-1.0.0en Mining Editor
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Second Example (Importing of fixpoints in ASCII format)

Process import fixpoint files

=N

The "Mining Editor" allows to import
fixpoint files in ASCII format.

LGN E  File > Open

Open File [ 7] <]
Laok in Ia ascii j gl

IZ] 100t 5000 tt lest2 tat

[Z] 10000 b4 GRT_taam.ord

[Z] 100kepword. TXT ] 11.asc
2] 100mized THT testids
=] 20000 bt test? asc

=

»

Open I
ﬂ Cancel |
I

File name: ISwiss asc

Files of type: Al Files (7]

Tenmplate I <hone:

L CTW)  ASCII-File search and select.
ERSICT Y Open the selected file.

=N

Follow the wizard onscreen
instructions to produce the correct
format.

ERSICTRY  Save the created file:
File - Save as

TPS400 Mining Ma%‘%’rﬁ&a@?ﬂom Www.SomaMuals Search And Download. Mi"ing Editor
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